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Copyright 

The data in this document may not be altered or amended without special notification from ETAS 

GmbH. ETAS GmbH undertakes no further obligation in relation to this document. The software 

described in it can only be used if the customer is in possession of a general license agreement or 

single license. Using and copying is only allowed in concurrence with the specifications stipulated in 

the contract. 

 

Under no circumstances may any part of this document be copied, reproduced, transmitted, stored in 

a retrieval system, or translated into another language without the express written permission of ETAS 

GmbH.  

 

© Copyright 2024 ETAS GmbH, Stuttgart 

 

The names and designations used in this document are trademarks or brands belonging to the 

respective owners. 

  



Release Notes | ASCET V6.4.8 

 

Template: 00TE00156 Release Notes V07 – released Page 3/27 

Table of Contents 

Copyright ................................................................................................................................................. 2 

1. Introduction .......................................................................................................................................... 5 

1.1. Definitions and Abbreviations ....................................................................................................... 5 

1.2. References .................................................................................................................................... 5 

1.3. Conventions .................................................................................................................................. 6 

1.4. User Documentation ..................................................................................................................... 6 

2. Product Definition ................................................................................................................................ 6 

2.1. Functions at a glance .................................................................................................................... 6 

2.2. General Description ...................................................................................................................... 7 

2.2.1. Safety Notice .......................................................................................................................... 7 

2.2.2. System Prerequisites ............................................................................................................. 7 

2.2.3. Software Prerequisites ........................................................................................................... 8 

2.2.4. Access Rights......................................................................................................................... 8 

2.2.5. Release Test Configuration .................................................................................................... 9 

2.3. Delivery ......................................................................................................................................... 9 

2.3.1. Used 3rd Party Software ...................................................................................................... 10 

2.4. Installation ................................................................................................................................... 10 

2.5. Licensing ..................................................................................................................................... 11 

3. Changes ............................................................................................................................................ 11 

3.1. What’s New ................................................................................................................................. 11 

3.2. Compatibility to Earlier Releases ................................................................................................ 11 

3.3. Fixed Problems ........................................................................................................................... 13 

3.4. Known Issue Reports .................................................................................................................. 22 

3.5. Known Issues .............................................................................................................................. 22 

4. Hints................................................................................................................................................... 23 

4.1. Release Notes ............................................................................................................................ 24 

4.2. Installation issues with Virus Scanner Tools............................................................................... 24 

4.3. Performance ............................................................................................................................... 24 

4.4. XML Workspace and Export/Import ............................................................................................ 24 

4.5. Double Byte Characters are not supported ................................................................................ 25 

4.6. Update of MinGW GCC .............................................................................................................. 25 

4.7. Changed Safety Advice for EHOOKS On Target Bypass .......................................................... 25 

4.8. Modelling of Messages in AUTOSAR Software Components .................................................... 26 

4.9. Customizable labels for ASAM-2MC Generation (*.a2l) ............................................................. 26 

4.10. Note on the use of discrete data types ..................................................................................... 26 



Release Notes | ASCET V6.4.8 

 

Template: 00TE00156 Release Notes V07 – released Page 4/27 

4.11. Advanced Information ............................................................................................................... 26 

5. Contact, Support and Problem Reporting ......................................................................................... 27 

 

  



Release Notes | ASCET V6.4.8 

 

Template: 00TE00156 Release Notes V07 – released Page 5/27 

1. Introduction 

1.1. Definitions and Abbreviations 

 

Term/Abbreviation Definition 

ASCET-DIFF 

 

ASCET Difference Browser 

Code Generation 

 

Code generation is the first step in the transformation of a physical model to 
executable code. The physical model is transformed into ANSI C code. 
Since the C code is compiler (and therefore target) dependent, different 
code for each target is produced. 

EHI ETAS Help Desk International 

File extension *.amd ASCET Model Description, XML based description format of ASCET models 

File extension *.axl Archived XML for ASCET  

HW Hardware 

KIR Known Issue Report – For severe Problem Reports which occur after a 
release, ETAS has introduced the Known Issue Report to inform affected 
customer immediately. The current Known Issues of former versions can be 
found on the ETAS website: http://www.etas.com/kir 

PR Problem Report 

SW Software 

Target The hardware a program or an experiment runs on, e.g. MPC55xx, TriCore, 
SH2 

WB Walkback: ASCET system error 

1.2. References 

[ASW_GS_EN] 

ASCET V6.4 Getting Started 

[ASW_INST_EN] 

ASCET V6.4 Installation Guide 

[ASW_ADMIN_EN] 

ASCET V6.4 Administration Guide 

[ASW_AR_UG_EN] 

ASCET V6.4 AUTOSAR User’s Guide 

[ASW_ARCONV_UG_EN] 

ASCET V6.4 AUTOSAR to ASCET Converter User’s Guide 

[ASW_ICON_REF_EN] 

ASCET V6.4 Icon Reference Guide 

[ASW_RP_UG_EN] 

ASCET-RP V6.4 User’s Guide 

 [ASW_SE_UG_EN] 

ASCET-SE V6.4 User’s Guide 

http://www.etas.com/kir
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[ASW_DIFF_INST_EN] 

ASCET-DIFF V6.4 Installation Guide 

 

1.3. Conventions 

The following typographical conventions are used in this document: 

 

OCI_CANTxMessage 

msg0 = 0; 

Code snippets are presented on a gray background and in the Courier font. 

Meaning and usage of each command are explained by means of 

comments. The comments are enclosed by the usual syntax for comments. 

Choose File → Open. Menu commands are shown in boldface. 

Click OK. Buttons are shown in boldface. 

Press <ENTER>. Keyboard commands are shown in angled brackets. 

The "Open File" dialog 

box is displayed. 

Names of program windows, dialog boxes, fields, etc. are shown in quotation 

marks. 

Select the file 

setup.exe 

Text in drop-down lists on the screen, program code, as well as path- and 

file names are shown in the Courier font. 

A distribution is always a 

one-dimensional table of 

sample points. 

General emphasis and new terms are set in italics. 

 

 NOTE 
 

Important hint for the user. 

 

1.4. User Documentation 

The set of ASCET manuals (see section 1.4) can be found on the DVD installation medium. 

2. Product Definition 

2.1. Functions at a glance 

ASCET is a development environment that enables the specification and implementation of control 

algorithms for embedded systems. ASCET V6.4 forms the core installation and must be installed first. 

The products ASCET-MD (Modeling & Design), ASCET-MDV (Model Viewer), ASCET-RP (Rapid 

Prototyping) and ASCET-SE (Software Engineering) for various micro controller targets can be 

installed on it independently. 

Together with the add-on products ASCET-SCM (Software Configuration Management) and ASCET-
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DIFF (Difference Browsing), ASCET forms a complete software development tool-chain 

2.2. General Description 

2.2.1. Safety Notice 

If ASCET is used to generate code for safety-related applications, the following assumptions are made 

on, and must be validated for, all users: 

• You are a trained software engineer who wants to use the ASCET model-based 

development approach to generate C code for use in a safety-related system. 

• You are a recognized expert in the design and implementation of software-intensive safety-

related systems. You have detailed knowledge about the failure modes of the system you 

are constructing and will have been the author or technical reviewer of the system safety 

case as it relates to aspects of the systems realized in software. 

Further information about the use of ASCET in safety-related applications is available in the following 

documents that are available on request from ETAS: 

• ASCET V6.4 Safety Manual 

• ASCET V6.4 MISRA-C:2012 Compliance Guide 

 

2.2.2. System Prerequisites 

The following minimum system prerequisites have to be met: 

 

Required Hardware 1,5 GHz PC 

1 GB RAM 

DVD-ROM drive  

Network adapter 

Graphics with a resolution of at least 1024 x 768, 32 MB RAM 

16Bit color and DirectX 7 

Required Operating 

System 

Windows® 10 x64 (Build 22H2 or higher) 

Windows® 11 x64 (Build 23H2 or higher) 

Required Free Disk 

Space 

3 GB (not including the size for application data) 

 

The following system prerequisites are recommended: 

 

Required Hardware 2,0 GHz Dual-Core PC or equivalent 

16 GB RAM 

DVD-ROM drive 

Network adapter 
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Graphics with a resolution of 1920 x 1200, 256 MB RAM 

Required Operating 

System 

Windows® 10 x64 (Build 1703 or higher) 

Windows® 11 x64 (Build 23H2 or higher) 

Required Free Disk 

Space 

>4,0 GB 

Required Software Microsoft® .NET Framework 4.6.2 or later 

Microsoft® Visual C++ Redistributable Package 2010 SP1 

Microsoft® Visual C++ Redistributable Package 2015 SP2 

 

2.2.3. Software Prerequisites 

 

You ensure that your PC has the following Microsoft® redistributables installed before installing 

ASCET: 

• Microsoft® .NET Framework 4.6.2 or later 

• Microsoft® Visual C++ Redistributable Package 2010 SP1 

• Microsoft® Visual C++ Redistributable Package 2015 SP2 

ASCET V6.4 cannot be used without installing at least one of the product executables: 

• ASCET-MD V6.4 

• ASCET-MDV V6.4 

• ASCET-RP V6.4 

• ASCET-SE V6.4 for a microcontroller target. 

Any combination of these products can be installed once ASCET V6.4 is present. For details see the 

ASCET Installation manual. 

ASCET uses XML technology for code preview and code documentation. Please see the “Hints” 

section for details on the required software installation. 

2.2.4. Access Rights 

2.2.4.1. Administrator Rights 

Administrator rights are: 

• Mandatory for installation 

• Optional for normal operation 

2.2.4.2. Registry Access 

ASCET places data in the Windows registry. 
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2.2.4.3. File System Access 

ASCET requires access to the following file-system locations: 

 

Folder Default(s) Installation Use 

<installation folder> C:\ETAS\ASCETx.y RW RW 

C:\ETAS\LogFiles RW RW 

C:\ETAS\ETASManuals RW R 

C:\ETASData\ASCETx.y RW RW 

C:\Program Files (x86)\ 

Common Files\ETAS 

 RW RW 

C:\Windows\SysWOW64  RW RW 

%ProgramData%\ETAS C:\ProgramData\ETAS RW RW 

C:\Users\<username>\ 

AppData\Local\Temp 

 RW RW 

C:\Users\<username>\ 

AppData\Roaming\ETAS 

 RW RW 

 

 

2.2.5. Release Test Configuration 

The ASCET release tests have been executed with the following configuration: 

• Host OS: 

− Windows® 10 x86_64 

− Windows® 11 x64 

• Compilers for host PC: 

− Microsoft Studio 2005 Express 

− Microsoft Studio 2008 

− MinGW GNU Compiler V13.2.0 

• Compilers for Prototyping targets: 

− MinGW GNU Compiler V13.2.0 

− QCC V6.5.0 

• µC on target testing: 

− MPC55xx, WindRiver Compiler V5.6.0 

2.3. Delivery 

The software is delivered with an installation routine on a DVD including ASCET software, 

documentation, tools, utilities, and further information. All software documentation is available in the 

Portable Document Format (PDF), which requires Adobe® Reader®. You find the installation link in the 

ToolsAndUtilities directory on the installation DVD. 

The DVD contains the following items: 
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Directory Meaning / Explanation 

ASCET V6.4 ASCET base system installation, including release notes 

ASCET-DIFF V6.4 ASCET Model Difference Browser installation 

ASCET-MD V6.4 ASCET Modeling & Design installation 

ASCET-MDV V6.4 ASCET Model Viewer installation 

ASCET-VIEW V6.4 ASCET Eclipse-based Model Viewer installation 

ASCET-RP V6.4 ASCET Rapid Prototyping installation 

ASCET-SCM V6.4 ASCET Software Configuration Management installation 

ASCET-SE V6.4 ASCET Software Engineering (for multiple targets) 

installation 

Documentation Documentation set for complete ASCET V6.4 product 

family (in PDF format) 

Graphic Graphical elements for the product installer program 

Main Main elements for the product installer program 

MDA V5.3 Measure Data Analyzer installation 

Partner ETAS Partner information for the product installer 

program 

Support ETAS customer support contact information for the 

product installer program 

ToolsAndUtilities ▪ ASCET-SCM_CM-Tool-Configuration 

(content also incl. in online help) 

▪ ASCET-SCM_Difference Browsing 

▪ ASCET-SCM_Driver Toolkit 

▪ ASCET-SCM_Subversion Client V1.6 

▪ ASCET-SCM_Subversion ScriptingAPI Example 

▪ CaliberRM Coupling 

▪ Licensing Tools for FlexLM 

▪ MikTex Documentation Generation 

▪ OpenSourceSoftware 

▪ WebService Example 

 

 

2.3.1. Used 3rd Party Software 

ASCET makes use of products that are released under the respective licenses. 

For details, please refer to the following documents on the DVD under the folder: 

\ToolsAndUtilities\OpenSourceSoftware\ 

 

2.4. Installation  

You must install the following Microsoft® Redistributables before installing ASCET: 

• Microsoft® .NET Framework 4.6.2 or later 
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• Microsoft® Visual C++ Redistributable Package 2010 SP1 

• Microsoft® Visual C++ Redistributable Package 2015 SP2 

These are available from Microsoft. 

After you have installed the r, follow the installation instructions on the DVD installer or the ASCET 

installer.exe. Further details are available in the installation manual [ASW_INST_EN]. 

 

2.5. Licensing 

The use of ASCET products is protected by electronic licensing. Valid licenses are necessary to install 

ASCET and its add-ons. The use of unlicensed ETAS software is prohibited. The required licenses are 

not included in this delivery. 

When you purchase ASCET licenses, you receive a separate entitlement letter. You activate the 

license using a self-service portal on the ETAS website (https://www.etas.com/support/licensing). For 

assistance, please consult the help file available on the start page of the self-service portal. During the 

activation process, you receive the necessary license keys per E-mail. 

3. Changes  

This chapter describes changes with respect to the previous version ASCET V6.4.7. 

3.1. What’s New  

The following changes have been made with this release: 

• MinGW GCC V13.2 has been introduced for the PC simulation and ANSI-C target 

• Code Generator uses Perl V5.38 64bit. 

• Support for EHOOKS V5.1, V5.2 and V5.3 for On Target Bypass 

• Removal of the support of EHOOKS V4.10 

• Modelling of Messages in AUTOSAR Software Components (SWC) 

• Improved and customizable ASAM-2MC (*.a2l) generation 

 

3.2. Compatibility to Earlier Releases 

ASCET V6.4.8 is functionally upwards compatible with previous versions. 
 

 NOTE 
 

There are no known Database incompatibilities to ASCET V5.0 / V5.1 / V5.2 / 

V6.0, V6.1, V6.2 & V6.3. 

 
 

https://www.etas.com/support/licensing
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ASCET V6.4.8 can import or read models that have been created with ASCET-SD V4.0.16 or higher.  

Before exporting or converting the database, a database defragmentation (menu 

Tools→Database→Performance Utilities→optimize database) is recommended. For older models, you 

have to import and export them with ASCET-SD V4.0.16 or V4.1.x first. 

After opening a database that was created using a previous ASCET version (e.g. ASCET-SD V5.2.2 

or V6.1.x), ASCET asks if you want to convert the database (see screenshot below). If you answer 

with yes, a path selection dialog is opened, and you can define the destination directory for the 

database conversion. A new ASCET V6.x database is created in that directory. The original database 

remains untouched. The converted database is now usable with ASCET V6.x but no longer with the 

old version.  

A similar conversion is made for export files (*.exp) created with previous versions. 

 

 

 

If you encounter difficulties in using your ASCET V5.x or V6.x Database under ASCET V6.4, please 

contact your local ETAS Hotline. 

 

 NOTE 
 

ASCET V6.4.8 provides *.amd export compatibility for the following legacy 

versions: 

▪ V5.2.2 
▪ V6.0.1 
▪ V6.1.4 
▪ V6.2.1 
▪ V6.3.1 
▪ V6.4.0 
▪ V6.4.1 
▪ V6.4.2 
▪ V6.4.3 
▪ V6.4.4 
▪ V6.4.5 
▪ V6.4.6 
▪ V6.4.7 
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3.3. Fixed Problems 

This section describes the set of fixed problems of the released version of ASCET V6.4.8. 

 

ID Title 

366958 

Bad line routing after copy/paste (or cut/paste) 

ASCET may corrupt the connection lines in the block diagram in case copy/cut & paste 

is used for multiple objects including their connection lines. 

546600 

No warning is generated if a method local variable and a message have the same 

name 

ASCET does not detect possible name clashes between local and global elements. 

From now on a warning will be issued (which can be promoted to an error): 

WARNING(WMdl9): element "<label>" already declared in component 

scope 

561813 

Reinitialize Variables does not work for the size of variant size arrys/matrices 

ASCET does reset the calibrated lengths of arrays/matrices with variant size to the initial 

size 

WHEN using "Reinitialize Variables" in the experiment 

584160 

Write access to a an element with "external access - SET" is not possible 

ASCET may throw unreasonable errors during code generation 

WHEN Set access is used for an instance variable 

AND Get access is not activated: 

ERROR(MMdl22): method "limitInt" not defined in class "Reference::Impl" 

ERROR(MMdl3): <limitInt> - due to expression - is not a left value for assignment 

584219 

Code generation takes a very long time 

The code generation takes a very long time in case the code optimization option 

"Common Subexpression Elimination" is active. 

586788 

Adding variables to CT block via tool bar not possible 

Inserting a variable into a Block Diagram Continuous Time Block is not possible even 

though it works for a similar ESDL block. 

586797 

Variables of type array cannot be inserted into CT-components 

It is not possible to insert an array type element in an Continuous Time Block. 

588040 

Export/import to Amd fails with schema validation error due to 

"_NOIMPL_[DEFAULT_1]_NOIMPL_" implementation name 

ASCET throws an XML validation error due to "_NOIMPL_[DEFAULT_1]_NOIMPL_" 

implementation name 

WHEN exporting/importing a model as AMD file 

AND an implementation set name contains [ and/or ] 

Export/import to amd fails with schema validation error  

594134 

Inconsistent generation of WMdl84 

In some case the warning WMdl84 does not reflect the suspicious code characteristic. 

So the phrasing has been changed to: 

WARNING(WMdl84): Possibly conflicting variable access may lead to 

unexpected behavior in the compiled code 
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597205 

Incorrect variant size check for message array 

ASCET shows an error dialog "The X size variant element is undefined" 

WHEN a global message array has a variant size  

AND the properties editor of the exported element is opened via the properties dialog of 

the imported element 

AND a system constant is selected for the variant size. 

600285 

Misleading "WARNING(WIle50): unreachable code after break statement --- 

removed" for statemachine 

ASCET may generate an unreasonable code generation warning "WARNING(WIle50): 

unreachable code after break statement --- removed"  

WHEN a statemachine contains transitions with always true conditions 

ASCET may optimize the generated code in a way which results in unreachable code 

even though this is not reflected in the model. 

603021 

Changes in ESDL code of statemachine are not saved 

ASCET does not persist manual code changes in ESDL methods of statemachines 

WHEN the editor for the code has been opened with the link from the monitor window 

(e.g. clicking on a warning message from a previous code generation) 

648308 

The Dependency attribute of System Constants is not displayed 

The Dependency attribute of System Constants is not displayed in the Browse view of its 

parent component. 

664962 

Generated code violates MISRA C:2012 Rule 10.3 

ASCET generates code which violates MISRA C:2012 Rule 10.3 

WHEN a temporary variable of an integer type is created automatically 

AND the result of a comparison is assigned to this variable. 

665074 

Too many warnings of type "WARNING(WIle365896): Udisc/Sdisc may be 

generated in an unexpected way" 

ASCET shows warnings or type "WARNING(WIle365896): Udisc/Sdisc may be 

generated in an unexpected way" by mistake for some record elements and 

messages 

666831 

System error during code generation for AUTOSAR projects with array of classes 

ASCET runs into a system error 

WHEN code is generated for a n AUTOSAR project 

AND the model contains arrays/matrices of classes 

A walkback occurs: 

SGCgComplexClassType does not understand getPhysInterval 

666863 

"Finding Unused Implementation Sets" does not scroll to the found 

implementation set. 

The database menu "Finding Unused Implementation Sets" lists the unused 

implementation set of the entire database.  

When double-clicking the list entry, the Implementation Editor of the component is 

opened but it does not scroll to the unused implementation set if there is a long list of 

objects. 

675321 

ASCET may generate integer literals without type indicator 

If the maxSize of an array is replaced automatically by an integer literal, this literal is 

used without the postfix which indicates its type. (e.g., "42" instead of "42U") 

677084 

System error when loading an experiment environment 

ASCET runs into a system error 

WHEN ASCET loads an experiment environment that measures data in an array or 
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matrix 

AND this element (array or matrix) has become a reference meanwhile 

The measure window for this element could not be restored and a system error occurs: 

UndefinedObject does not understand @  

679919 

Values of elements in numerical editor may differ from value in data model 

For numerical elements ASCET allows to enter the initialization data in a numerical 

editor without any length limitation. Even though the decimal places ion the data model 

is limited. Therefore, the used value in the model may not be exactly the same like the 

entered one. To indicate the possibly changed value ASCET now shows the stored and 

the displayed value in the numerical editor. 

680037 

Deleting, Adding, or Renaming an element from the Outline does not update the 

Syntax Highlighting of the Model Identifier 

The marked identifiers in an ESDL or C code editor are not updated automatically in 

case elements are deleted, renamed, or added. 

680961 

ASCET-Links in Monitor are wrong colored and incorrect 

ASCET may show invalid ASCET Links in the Monitor window 

WHEN ASCET adds information containing ASCET-Links into the ASCET monitor 

AND the monitor window has not been opened at this time 

The information is not correct reconstructed if the monitor is opened afterwards. This can 

result in some invalid ASCET-Links which are not working like intended. 

686969 

ASCET runs in a system error when using "Open Component in Project Context" 

ASCET runs into a system error 

WHEN using the button "Open Component in Project Context" from the "Model Path of 

export" section in the "Path for" dialog 

AND the component has scope "Imported" 

AND the "Exported" of the component does not reside in the project but in another 

component 

A walkback occurs: 

SGVariable does not understand getMakeConfigForElement. 

700041 

Multiple declarations for record with "Object Based Controller Physical" Cgen 

setting 

ASCET may generate redundant code 

WHEN the "Object Based Controller Physical" code generator setting is used 

AND a record is used in a message-array 

ASCET may wrongly generate multiple unnecessary implementations for the same 

record. 

Note: In case ASCET is configured to ignore the implementation in the record name 

template, ASCET generates uncompilable code. 

Here, the multiple implementations all share the same name in the generated c code, 

which is illegal in C. 

709072 

Walkback in code generation when generating code two times for a workspace 

ASCET runs into a system error 

WHEN generating code for a project in a workspace twice 

AND a statemachine with a broken graphical representation is included 

A walkback occurs: 

ExCLDTIndexOutOfRange) Index out of range.: 1 

710858 

Incomprehensible constant folding info messages 

ASCET throws multiple incomprehensible info messages IMdl40 and Imdl43 (constant 
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folding - reduced IF-THEN statement) 

WHEN generating code for a model with IF condition with a system constant which 

generates a prepocessor command. 

710941 

System Error during EHOOKS automapping 

ASCET runs into a system error  

WHEN an EHOOKS On-Target-Bypass is configured 

AND the Automapping features is used 

A walkback occurs: 

WB_IDispatch_call_returned_an_exception._ErrorCode_0x800706BA_Sou

rce_mscorlib._The_RPC_server_is_unavailable. 

711794 

EHOOKS: EH_copy_ECU_variable is still available for the input tab although the 

original ECU variable was deleted in the output tab 

Even though the ECU variable to be overwritten has been removed from the On-Target-

Bypass configuration of EHOOKS, the related backup copy variable is still available in 

the selection. 

713368 

Customer Data lost in Implementations or Data 

ASCET loses Customer Data in Implementations or Data 

WHEN the scope of an Array/Matrix is switched from Local to Imported/Exported or back 

713746 

Imported system constant used for variant size matrix as method argument 

undefined in C code 

ASCET does not generate the definition of a system constant macro 

WHEN the system constant has scope "Imported"  

AND is used as the variant size of a matrix/array method argument. 

713862 

Save button in Project Editor not active after changes 

After doing changes in the mapping of an EHOOKS project the Save button is not 

consequently active to be pressed for saving. 

714270 

'Get ECU Labels and Map' not working for record elements 

ASCET may not be able to map record elements to EHOOKS signals from the ECU for 

On-Target-Bypass. 

714441 

Customer specific Engineering: ASCET Graphic Generator enhancement 

Upgrade the ASCET Graphic Generator backend to V6.4.7 (x64). 

714828 

Method name generated improperly if name of representation contains 

underscore 

ASCET may generate unexpected code 

WHEN the method name and/or the implementation set include an underscore ('_') 

ASCET may generate shortened method names. 

Solution: A new tool option "Disable Truncation of service routine names" has been 

introduced to configure the desired behavior. 

715167 

Duplicate prefixes for types are generated for maps 

ASCET does not generate the correct type names for matrix types in AUTOSAR code 

generation. The name template for Matrix types in the ARXML options is not evaluated 

correctly. 

715659 

ASCET runs in a system error when using "Open Component in Project Context" 

ASCET runs into a system error 

WHEN using the button "Open Component in Project Context" from the "Model Path" 

section in the "Path for" dialog 

A walkback occurs: 

Arrays should not implement this method  
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715922 

Child dialogs may pop up partly outside the visible area 

ASCET opens a child dialog partly outside the visible area 

WHEN multiple screens are used 

AND the resolutions are not the same  

AND/OR the areas of the screens are placed unaligned. 

716016 

"Create ASCET Link" does not work for "Data" and "Implementation" tab 

ASCET links are not copied to the clipboard  

WHEN using the "Create ASCET link" from the context menus of items in the 

Implementation and Data browse view of components 

718170 

System error when editing implementation of Record 

ASCET runs into a system error 

WHEN an Implementation of a record element in a module is edited 

A walkback occurs: 

WB_UndefinedObject_does_not_understand_value 

718381 

Erroneous internal memory management 

The ASCET internal memory management may in very rare cases lead to an allocation 

of insufficient memory for reading/writing objects from/to the database. 

718869 

Wrong assignment when using "Extra Reference Connector" 

ASCET does not generate a pointer access correctly  

WHEN the "Extra Reference Connector" is activated for an Out argument of a method  

AND it is used as argument for another nested method call 

719081 

Navigation Tree shows in Hierarchies double Entries and filtered Entries 

ASCET shows multiple entries for the same hierarchy in the Navigation view even 

though the filter settings should suppress these. 

719334 

System error during code generation for model with nested loops 

ASCET runs into a system error during code generation 

WHEN a model contains nested loops  

AND the used variables in deepest loop have been modified prior code generation. 

A walkback occurs: 

Primitive failed in: Behavior>>#new: due to Not enough memory 

719945 

Throw warning for possible uninitialized process local pointer 

ASCET misses to throw a warning  

WHEN a process/method local variable is set to "Reference" 

AND the pointer to this variable is not initialized explicitly (e.g. read from external source) 

A new warning has been introduced:  

WARNING(WMdl823): possible uninitialized reference of local 

variable "locvar" 

721080 

Rescale sequence without function when wrong process selected 

ASCET does not rescale when the command "Rescale Sequence Calls" in BDE is used 

WHEN it is applied to a sequence call that belongs to a process different from the 

selected one 

722016 

Arrays and matrices are still shown in the navigation tree 

ASCET still shows arrays and matrices in the navigation tree of a component 

WHEN the option Show Primitive Elements under Tool Options -> Appearance -> Tree 

Pane -> Navigation Tree is deactivated. 

722703 

Redundant display of warnings concerning EHOOKS message mapping 

ASCET shows multiple warnings in a dialog concerning unresolved messages 

WHEN using the EHOOKS mapping of messages to ECU variables. 
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723252 

Imported system constant undefined in C code for 2nd code generation 

ASCET does not generate the definition of a system constant macro 

WHEN this system constant has the scope "Imported"  

AND this system constant is used as the variant size of a matrix/array method argument 

AND the code generation is started for a second time without any model change or 

Touch Recursive 

725172 

Wrong default settings for the Calibration attribute in the element properties 

ASCET does not set the default calibration access behavior of an element 

WHEN changing the "Kind" in the properties window of an element in the properties 

editor 

E.g.  the calibration access is set to Write and Read when creating a parameter, but the 

calibration access keeps the setting of the variable) when creating a variable and 

changing it to a parameter. 

725247 

System error when generating code for incomplete model 

ASCET runs into a system error  

WHEN generating code 

AND the model contains references to missing child components. 

A walkback occurs: 

CTError does not understand do: 

725412 

Extremely low performance with specific complex projects 

ASCET has an extremely low performance 

WHEN ASCET V6.4.5 ff is used 

AND certain operations are executed in a (complex) project context (e.g. BDE handling, 

code generation, ...) 

725521 

Enum array initialized with '0' when activating Sparse Array generation 

ASCET may generate initialization data of the wrong type 

WHEN arrays of enumeration types are used 

AND the Project Property "Generation of Enums" is set to "Enumeration" 

AND the generation of Sparse Arrays is activated in the target options 

727328 

Import/Export of EHOOKS messages takes very long if ECU variable info is 

checked 

ASCET needs a very long processing time  

WHEN exporting/importing messages from the EHOOKS tab of an EHOOKS project 

728330 

Multiplication with zero may be wrongly optimized 

ASCET generates wrong compilable code 

WHEN multiplying with a constant zero 

OR performing a remainder operation with zero as numerator 

ASCET optimizes the expression, possibly discarding side-effects like function calls or 

increment operators. 

728805 

Index information for Record implementation gets lost on AMD import 

ASCET may lose the index information in the record implementation when further 

element attributes from the list below in the same implementation set are imported: 

 *  AUTOSAR: 

invalidationPolicy, aliveTimeout, handleNeverReceived, handleOutOfRange, 

handleDataStatus, policy 

 *  Complex elements: 

memoryLocationInstance, cacheLocking, rescalingFormula, memoryLocationReference 

729261 WB: 'Primitive failed in: Object>>#at: due to Index out of range in argument 1' for 
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not optimized method calls 

ASCET runs into a system error 

WHEN codegen.ini contains the following options: 

ConditionalDataStructure = true 

conditionalInputValues = true 

extendedConditionalInputvalues = true 

AND the implementation setting "Optimize method calls" is deactivated 

AND variant size arrays are used 

A walkback occurs: 

Primitive failed in: Object>>#at: due to Index out of range in 

argument 1 

732159 

System error during code generation 

ASCET runs into a system error 

WHEN attempting to compile code similar to z = (x++) * 0 

An arbitrary walkback may occur and a fatal error: 

ERROR(): Internal error: Shift expression with negative constant 

732468 

"Potentially Used" of "Show Unused Elements" does not work 

ASCET may wrong information in the "Potentially Used" column of "Show Unused 

Elements" view. 

So this column has been removed and is ensured that the information about the unused 

elements is always correct. 

733776 

Missing limiter when using arithmetic services 

ASCET generates wrong compilable code 

WHEN arithmetic services are enabled 

AND the target of an assignment has limiting enabled 

AND this target has a range that is smaller than the set of values of its assigned 

implementation type  

AND this target's range matches the set of values of a smaller type 

(e.g. the target has implementation type S32 and value range 0 to 65535, which 

matches U16) 

ASCET wrongly does not limit the assignment to the target's range. 

734781 

Runnable incorrectly encapsulated with unused code macro 

ASCET may disable runnables with unused code macros 

WHEN AUTOSAR is used 

AND the generation of system constants is enabled 

AND the runnable in question does not have any side effect 

735446 

Default path of Cgen directory 

Due to common regulations concerning IT security the default path of the Cgen directory 

should not be under C:\Program Files anymore. 

737609 

System Error when generating code for do-while loop 

ASCET runs into a system error 

WHEN code is generated for a model with a switch case statement or a statemachine 

AND that model contains a do-while loop 

A walkback occurs: 

receiver must be a boolean 

738598 

System error when toggling scope of system constant 

ASCET runs into a system error 

WHEN the properties editor is used 
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AND a system constant is changed from imported to exported and back again 

A walkback occurs: 

UndefinedObject does not understand primitiveValuesAt: 

738831 

Errors on importing AUTOSAR files not displayed 

When importing an AUTOSAR XML file the occurring errors are not displayed in ASCET. 

739496 

Show unused elements erroneously detect and delete mapped NV-Data elements 

ASCET shows variables as unused when executing "Show unused elements" 

WHEN they are mapped to NV Data interfaces in an AUTOSAR Software Component. 

739832 

Invalid input quantity for tables in ASAM-2MC file 

Using an implementation cast as input for a distribution causes ASCET to write the 

name of the implementation cast into the ASAM-MC2 file as distribution source. 

741154 

MISRA 14.2 violation in for-loops over bounded types 

ASCET may generate code which is not MISRA-C compliant 

WHEN a loop is used which is modelled or optimized to an empty loop condition 

ASCET now indicates such a possible violation of the MISRA-C rule 14.2 by an 

additional warning during code generation: 

WARNING(WMdl8886): The loop condition is always <true> 

743725 

Wrong number of code generation errors/warnings/information messages in the 

Monitor window 

ASCET may not show the correct number of code generation 

errors/warnings/information messages in the Monitor window, if a custom code 

generation process is used which consists of multiple steps. 

743730 

Missing comments for sequence calls 

ASCET may generate code which could miss the correct comments belonging to 

sequence calls including the corresponding traceability information. 

745969 

System error when editing component data 

ASCET runs into a system error 

WHEN the component contains a variable with a deleted element 

A walkback occurs: 

UndefinedObject does not understand hasDatas 

746261 

ASCET generates code using unknown enumeration labels 

ASCET generates code using unknown enumeration labels 

WHEN the settings for "Resolve System Constants" = "Generation Time" and 

"Generation of Enums" = "Enumeration" 

748484 

Arrowheads of statemachine transitions are broken 

ASCET shows broken arrowheads for statemachine transitions  

WHEN  "Orthogonal Lines" are used and a line width thicker than the default is selected. 

748546 

System error during code generation 

ASCET runs into a system error 

WHEN code is generated for a project with target "PC"  

AND the setting for the project property "Message Usage Variant" is 

"NON_OPT_COPY_TASK" 

AND receive messages of type "Log" are used 

A walkback occurs: 

SGIlTempVarInitVisitedState does not understand first 

749891 

ASCET generates unexpected special characters in comments 

ASCET generates special characters in a comment which belongs to an #if statement 

WHEN activating the option "Variant Coded Data Structures" 
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753562 

Automatic conversion of OUT or INOUT argument of type bit 

ASCET converts an OUT or INOUT argument of type bit to bool in the generated C code 

without adding an appropriate temporary variable. 

753902 

ASCET warns against database size 

In previous ASCET versions (before V6.4.7) a 32bit architecture was used which limited 

the size of a database to a maximum of 4GB. As a precaution measure a warning was 

issued when reaching a size of 3.5 GB already. Since ASCET V6.4.7 a 64bit architecture 

has been used which allows bigger database sizes now. The warning is not necessary 

anymore. 

754708 

Unclear error message if a workspace from a newer version is opened 

ASCET shows a not very helpful error message if a workspace contains a component 

from a newer ASCET version: 

ERROR: Failed to access an item: .... 

The error message has been improved to: 

### ERROR: General XML tools exception: Unable to load <model 

file>.amd -> 'Transformation from <newer version> to current 

failed' 

757101 

Missing system constant dependency for system constant used as variant size for 

an array 

ASCET generates code which misses the definition of a system constant 

WHEN the system constant is used to define the size of a variant size array/matrix 

AND the option ConditionalDataStructure = true is used in the codegen.ini 

759832 

Web Services: Wrong character transformation when using non-standard ASCII 

characters 

ASCET performs a character conversion from UTF8 to the currently used windows code 

page two times. This results in wrong and/or invalid characters when using non-standard 

ASCII characters - like a German Umlaut - which cannot be processed in ASCET 

correctly. 

759867 

System error during EHOOKS Build 

ASCET runs into a system error 

WHEN code is generated for Controller Target  

AND Access Macros are activated for the selected target  

AND a method (e.g. 'called') is specified with a variable size ARRAY type argument 

AND that method is called from another executable with a local element of array type 

used as runtime parameter 

A fatal error occurs: 

FATAL (ECCO1200): Can't call method "getStackVariable" on an 

undefined value at <path> 

761245 

Missing sequence calls of Statement block in the Navigation view 

ASCET does not show all sequence calls of a Statement block 

WHEN they belong to direct access methods of elements of a record  

761354 

Writing a DCM file fails for AMD imported models without element OIDs 

Importing an AMD file in ASCET that is created by a 3rd party software without the OID 

information for elements and components causes to skip the initialization of an internal 

flag in the data configuration. 

This causes an error message when trying to write a DCM file for those data 

configuration. The write operation is aborted. 

762184 
Automatic Sequence Call scaling can mix up the sequence order 

ASCET may change the existing order of sequence calls 
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WHEN using Statement Blocks  

AND the Statement Blocks are connected to signal flow operators (IF, ...) 

AND automatic sequencing (Tools->Sequence Calls->Scale to Step Size) is used. 

762841 

Wrong optimization of code with compare operator 

ASCET generates wrong compilable code 

WHEN an implementation based code generator is used 

AND the model (or the intermediate code) includes a relational operator (">" or "<") with 

constants on both sides of the relation (Note: The constant might also stem from scaling 

factors) 

AND the sign of the two constants is different 

AND the constants can be optimized to only one constant on one side of the relation 

The generated code wrongly replaced a relational operator by its inverse operator. 

763525 

System error during code generation for model with direct access to array 

ASCET runs into a system error  

WHEN generating code for an ESDL model 

AND the model contains a direct access to an array in a subclass 

AND the code is syntactically incorrect 

A walkback occurs: 

SGCgContReal64Type does not understand readOfReferencedObject  

766075 

Generation of eps files leads to missing icons 

ASCET generates EPS graphics without the correct icons for referenced components 

WHEN these components are used within a hierarchy. 

 

 

3.4. Known Issue Reports 

If a product issue develops, ETAS will prepare a Known Issue Report (KIR) and post it on the internet. 

The report includes information regarding the technical impact and status of the solution. Therefore, 

you must check the KIR applicable to this ETAS product version and follow the relevant instructions 

prior to operation of the product. 

 

The Known Issue Report (KIR) can be found here: 

 

http://www.etas.com/kir  

3.5. Known Issues 

This section describes the set of known problems of the released version of ASCET V6.4.8. 

ID Title 

293145 

[50828] 

1GEE Online Experiment: Change measure rate is always grayed 

out 
  

After adding a variable to a measurement window, the acquisition rate 

(alias raster / OS task) cannot be changed later on because the entry 

in the context menu is always disabled (grayed out). 

http://www.etas.com/kir
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293808 

[52675] 

Virtual Parameter not calibrate-able in offline simulation 
  

Virtual variables are calibratable, but virtual Parameter are not 

calibratable in offline simulation, see attached example. 

=> v_param is defined as Existence: virtual 

=> v_param is defined with Calibration: YES 

297593 

[68869] 

Offline experiment: Hierarchy States not correctly reinitialized 

when Hierarchical CGEN 
  

In the ASCET offline PC-experiment, hierarchy state variables in 

State Machines are not reinitialized when "Experiment Stop" and 

"Reinitialize Both" is executed. 

The workaround is, to close and open the experiment whenever a full 

initialization is required. 

304106 

[90653] 

Data buffer returned from target has invalid length, the error 

occurred while retrieving the pseudo address for ... 
  

ASCET supports only components with a maximum of 999 methods 

(including direct access methods) when running an experiment on an 

experimental target. 

334631 Code Generation fails after conversion to ASCET V6.1 when 

array or matrix of kind "parameter" is used as method argument 
  

If a method component, using an array or matrix as method argument, 

is converted to ASCET V6.1 or higher, 

ASCET enables the new introduced IN and OUT attributes for this 

argument to ensure that it is possible to write to the array or matrix 

argument within the method code. 

ASCET code generation fails 

WHEN the converted method is called by another component by 

using an array or matrix of kind "parameter" 

The code generator will report the error MMdl104 since parameters 

are not writeable. 

Workaround: The OUT attribute must be unset for the array or matrix 

argument in the method definition. 

704753 Moving dialog boxes 

In case the scaling or resolution of the PC is changed while running 

ASCET- even by connecting/disconnecting of external screens - child 

dialogs (like e.g. import dialog) are moving automatically 

unexpectedly on the screen. After a restart of ASCET the problem 

does not occur anymore. 

712375 Path settings with spaces 

In the tool options you can set different paths to folders used by 

ASCET under Environment->Paths. Paths with spaces must be 

specified with " at the beginning and end (e.g., "C:\Program 

Files\ETAS\ASCET6.4"). 

 

 

4. Hints 
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 NOTE 
 

Code generation 

It is recommended to perform a clean code generation directory before doing 

a complete project build. Otherwise, ASCET may not consistently consider all 

changed options during make. 

 

4.1. Release Notes 

These release notes are copied to the ETASManuals\ASCET V6.4 folder during installation and can 

be opened from there. 

4.2. Installation issues with Virus Scanner Tools 

In certain cases, an active Virus Scanner may cause a failing installation process. It is recommended 

to deactivate the Virus protection for the installation sources and the Ascet.exe installation process. 

4.3. Performance 

As consequence of the migration of the tool framework to a 64bit environment with ASCET V6.4.7 and 

other general improvements there might be an expected loss of performance particularly in the code 

generation process. 

4.4. XML Workspace and Export/Import 

For externally created or adapted XML files compliance to the XML schemas (to be found in the 

installation directory of ASCET) is important to obtain consistent and readable ASCET components. 
 

 NOTE 
 

Operating ASCET's GUI during import of *.axl & *.amd files 

During import of the XML-based description files (*.axl or *.amd), it is possible 

to operate ASCET’s GUI. This is not recommended, as inconsistencies of the 

manipulated ASCET objects may occur. 

Please do not work with ASCET during import of *.axl or *.amd files. 
   

It is not possible to create folder hierarchies/components with pathnames exceeding 180 characters, 

for legacy DBs or imported components a longer pathname is possible, but ASCET V6.4.8 won’t 

export such components/folders. The user will be notified to reduce the path length by renaming/move 

the respective component. 
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4.5. Double Byte Characters are not supported 

ASCET does not support the use of double byte characters. You may use double byte Characters, but 

the correct post processing for documentation can not be assured. The ASCET code generation is not 

affected as ANSI-C does not make use of double byte characters. 

4.6. Update of MinGW GCC 

With ASCET V6.4 the shipment of the Borland V4.5 Compiler with the ASCET installation has been 

discontinued.  

From ASCET 6.4.8 on the default compiler for the PC experiment is the MinGW GNU Compiler 

V13.2.0 which is part of the delivery. 

 

4.7. Changed Safety Advice for EHOOKS On Target Bypass 

The ETAS product ASCET6 is an established tool for the development of control unit software in the 

automotive sector. The development of software includes early validation on real hardware, in test 

benches and also in test vehicles at many customers, also known as Rapid Prototyping. However, 

such use can affect safety-relevant systems or data and therefore requires proper use by trained 

personnel. The exact legally relevant information is explained in the ETAS Safety Advice, which is part 

of the software installation. 

ASCET 6.x can also be used to generate series codes; this functionality is made possible by the 

ASCET-SE add-on. The customer is responsible for releasing the code for series use and can of 

course rely on the capabilities of our certified code generator. However, ASCET-SE also contains 

examples that are not intended for series use; these are explicitly pointed out during code generation.  

In a prototyping use case in combination with the ETAS tool EHOOKS (Ontarget Bypass), an incorrect 

classification occurred. An interpolation routine for use in conjunction with EHOOKS was declared as 

not "released". ASCET-SE for EHOOKS therefore previously contained - like all other SE targets - a 

corresponding user note ("Disclaimer for interpolation routines.txt"), which referred to use for 

production code development. However, there is nothing to prevent it from being used in prototyping 

use cases in accordance with the safety advice. The disclaimer will therefore be removed from the 

EHOOKS target for future versions of ASCET V6.x.  

 

There are technical and historical reasons for this incorrect classification: EHOOKS support is 

implemented in ASCET as an ASCET-SE target, and the same mechanisms and disclaimers apply as 

for the creation of ECU production code. 

 

• Program code and/or control actions of programs, which have been developed or modified 

as well as data of any kind, which have been identified by using ETAS products, will need to 

be verified with respect to reliability, quality and suitability prior to any use or dissemination. 

• Use of this ETAS product or any program code, program control procedures in the public 

domain (e.g. on public roads) should not occur unless they have been tested and verified as 

being safe in advance. It is therefore recommended to use the products only in closed and 
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designated test environment. 

 

The same safety advice is also displayed when starting the ASCET, INTECRIO and EHOOKS tools. 

4.8. Modelling of Messages in AUTOSAR Software Components 

ASCET now allows to use elements of kind “Message” in AUTOSAR Software Components (SWC) 

like on modules. It is possible to create and use messages in SWC like any other element. They can 

also be used in for the internal and external AUTOSAR mapping. ASCET will generate RTE access 

macros accordingly. 

 

4.9. Customizable labels for ASAM-2MC Generation (*.a2l) 

With ASCET V6.4.8, it is possible to flexibly define the names of the signals in the A2L file (ASAM-

2MC) generated by ASCET. The signal names for MEASURMENTs and CHARACTERISTICS are 

generated based on the associated variables and parameters in the ASCET project. These elements 

are in the hierarchical structure of the project and can be assigned via it. The hierarchy information is 

used to generate the names. 

It is now possible to define the number of hierarchy levels and their alignment in the names of the 

various signal types and to extend them with your own strings. This can be done using the 

corresponding options under Targets → <target> → Write ASAM-2MC/DCM.  

Detailed information can be found in the corresponding option descriptions. 

4.10. Note on the use of discrete data types 

For the discrete data type Limited Integer, the code generator does not usually apply any 

optimizations to improve the accuracy or runtime of arithmetic operations. This is a deliberate 

characteristic of this data type. 

However, certain operations are still optimized - e.g., multiplications with factors that represent a 

power of two - if no negative side effects are to be expected. In this respect, this optimization behavior 

may be unexpected, as very similar models that differ, for example, only by such factors can lead to 

very different code.  

Nevertheless, we definitely recommend the use of the discrete data types Limited Integer (LimitInt) 

and Wrap Around Integer (WrapInt) introduced with ASCET V6.4. 

 

4.11. Advanced Information 

The following options in Build in the ASCET project properties are deprecated and will be removed in 

the future: 

• Force parenthesis for Binary Logical Operators 

Parentheses will always be used. This change has no impact on behavior. 

• Add parenthesis for readability. 
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Parentheses will always be used. This change has no impact on behavior. 

• Casting 

ASCET will use MISRA casting only in the future. 

• Allow Double bit Size for Division Numerators 

This option has no effect on 32-bit targets (because numerators cannot be doubled to 64-bit). 

The use case for 16-bit (ternary services with intermediate values of a larger value range) is 

now implemented independently of this option. 

• Use SHIFT Operation on Signed Values instead of MUL Operation 

ASCET will always use a MUL operation in the future. When this option is enabled, it can 

change mathematical behavior and will break MISRA-C compliance. In modern optimizing 

compilers, the compiler is intelligent enough to perform this optimization without needing a “hint” 

from code generation. 
 

The following options in Build → Code Generation → Optimization in the ASCET project 

properties will be deprecated in a future version of ASCET: 

• Optimize Direct Access Methods (One Level) 

Subsumed into the option for multiple levels.  
 

The following options in Build → Code Generation → Optimization → State Machine in the 

ASCET project properties will be deprecated in a future version of ASCET: 

• Optimize Static Actions (Restricted Modelling) 

Disabling this option leads to state machine permits strange behavior with respect to execution 

order of static actions and transition conditions. This option will always be enabled, thus making 

models easier to comprehend. 

• Generate well-formed switch. 

A well-formed switch will always be generated (as required for MISRA compliance). 

5. Contact, Support and Problem Reporting 

For details of your local sales office as well as your local technical support team and product hotlines, 

take a look at the ETAS website: 

 

ETAS subsidiaries www.etas.com/en/contact.php  

ETAS technical support www.etas.com/en/hotlines.php 

 

http://www.etas.com/en/contact.php
http://www.etas.com/en/hotlines.php

